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Chapter 1: Introduction
Thank you for choosing the Unitrends Free virtual appliance. You are minutes away from protecting your environment.

With virtual appliance deployments, the appliance’s initial disk stores no unique data or backups. Storing this data on
different disks or external storage arrays enables you to reattach the storage to a different Unitrends Free appliance,
so you can retain your original appliance’s settings and backup data if you need to deploy a new virtual appliance.

This guide includes instructions for deploying using new storage and for deploying using storage that contains backup
data from another virtual appliance. The process is similar for both deployment types, and the applicable sections
cover any variations.

Note: Attaching backup storage that contains backups from another Unitrends Free appliance is supported only if
the original appliance is running the same operating system as the newly deployed appliance. Appliances
deployed with version 10.3.6 or higher run CentOS 7. Appliances deployed with older versions run CentOS 6.

Deployment consists of creating the Unitrends Free virtual machine (VM), attaching backup storage, and configuring
appliance settings. Terms used in this guide are defined in the following table:

Term Definition

Added disk VMDK virtual disk storage created by running the Unitrends Free EXE installer, by deploying the
Unitrends Free OVA file, or by using the ESXi host. A VMDK can be created from direct attached
storage (DAS) that is internal to the ESXi host, or from external SAN or NAS storage that is connected
to the ESXi host over the iSCSI, NFS, or CIFS protocol. Also called attached disk storage.

Appliance The Unitrends Free system that backs up and recovers data. Consists of the Unitrends Free VM,
Unitrends software, attached storage, and additional configuration settings.

EXE
installer

Unitrends Windows executable installer used to deploy the Unitrends Free VM on your ESXi host. Use
to deploy to most paid versions of ESXi. (For paid ESXi 7.0 versions, use the OVA method instead.)

Host ESXi server that houses the Unitrends Free VM. Also called a hypervisor.

Initial
backup
storage

Storage you attach to the Unitrends Free VM that is used to store appliance configuration settings and
backups. You attach this storage after deploying the Unitrends Free VM, but before you configure the
appliance using the Quick Setup Wizard. The initial backup storage must be 200GB - 2TB in size.

Initial disk 100GB disk used to create the Unitrends Free VM. While installing the EXE or OVA, you select a
datastore on the ESXi host that the installer uses to create this disk.

OVA file Unitrends OVA file used to deploy the Unitrends Free VM on your ESXi host. Use to deploy to free ESXi
versions and to paid ESXi 7.0 versions.
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Term Definition

Quick
Setup
Wizard

The Quick Setup Wizard automatically launches the first time you access the appliance UI from a web
browser. Work your way through this wizard to configure additional appliance settings, such as date
and time, hostname, and email.

Unitrends
Free VM

Virtual machine created by deploying the Unitrends Free OVA file or by running the Unitrends Free EXE
installer.
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Chapter 2: Requirements and Considerations
Before deploying your Unitrends Free appliance, verify that the following requirements have been met:

• "Hypervisor requirements and considerations"

• "Network requirements"

• "Port requirements" on page 9

• "Web access" on page 10

• "Requirements and Considerations"

Hypervisor requirements and considerations
Unitrends recommends running your appliance and the VMs it protects on different hosts to avoid losing your VMs and
their backups if one of the hosts fails.

You can deploy Unitrends Free on the following hypervisors:

Hypervisors for
Unitrends Free Deployment method

Free versions of ESXi
5.5, 6.0, 6.5, 6.7, or
7.0

Paid versions of ESXi
7.0

OVA

Paid versions of ESXi
5.5, 6.0, 6.5, or 6.7

Use either of these:

• EXE - Run the EXE installer from a Windows machine on which both .NET Framework
3.5 and 4 have been installed. For details, see the following Microsoft documents:

– Installing the .NET Framework 3.5

– Microsoft .NET Framework 4

Note: The EXE installer is not supported in some paid ESXi environments. If
necessary, use the OVA method instead.

• OVA

Network requirements
There are several addresses you should permit for all deployments. All of these ports are outgoing connections from
the Unitrends appliance. We do not require incoming NAT of ports or exposing the unit to a public IP, only outgoing
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communication from a local source Unitrends appliance is needed.

IMPORTANT! Never expose the appliance Web UI or SSH connections to open external ports. Never deploy the
Unitrends appliance on a public IP. All incoming ports to a Unitrends appliance must be firewall
protected. Privately operated hot backup copy targets should be deployed in such a way as to
secure the VPN connection to only trusted source external IPs.

Network requirements vary by whether DHCP is available in your environment.

DHCP is available

If DHCP is available in your environment, review these requirements and considerations before you deploy the
appliance VM:

• If your environment goes offline for an extended period of time, your appliance may be assigned a new IP address
from the DHCP server. This may cause a temporary loss of backup and recovery functionality. If this occurs, see
KB 360013261398 for instructions on how to proceed.

• The eno1 adapter is, by default, configured for DHCP.

• DHCP cannot be a configured for more than one network adapter at any given time.

• A network adapter configured for DHCP cannot be managed via the appliance user interface (UI) described in the
Administrator Guide for Recovery Series, Recovery MAX, ION/ION+, and Unitrends Backup unless you intend to
assign it a static IP address.

• Unitrends appliances intended for use as backup copy targets must be assigned static IP addresses.

DHCP is not available

If DHCP is not available in your environment, or if you intend to use this appliance as a backup copy target, you must
configure a static IP address for the appliance. Initially, the Unitrends Free VM is created with the IP address
10.10.10.1 and the subnet mask 255.255.255.0. If this IP is currently being used in your environment, disable it until
you bring the Unitrends Free VM online and assign it a new IP address. During deployment, you must configure the
following settings:

• An IP address and subnet. The IP address and the subnet enable communication between the appliance and
other machines on your network.

• A gateway. A gateway enables communication between the appliance and machines on different subnets.

• Appliance DNS settings, required for the following:

– To connect the appliance to the Internet.

– To add assets using only their hostnames (rather than by fully qualified domain names).

– To update your appliance from the user interface (UI).

– To access the Unitrends Community forums from the UI.

Note: You can obtain the above information from your network administrator.
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Port requirements
Additional ports must be open if there is a firewall between your appliance and its protected assets, and for
connectivity to the Internet. See these tables for details:

• "Connectivity between the appliance and its protected assets"

• "Connectivity between the appliance and the Internet"

Connectivity between the appliance and its protected assets

Task Port, Protocol, and
Rule

Hostname and IP
Address Notes

Protect assets
that are
separated from
the appliance
by a firewall.

1743:

• TCP

• Outbound from
appliance

• Inbound from
protected asset

1745:

• TCP

• Outbound from
protected asset

• Inbound from
appliance

Appliance hostname
and IP

Asset hostname and IP

If a firewall exists between the appliance and
the assets (machines) you wish to protect,
open these ports to enable communication
and data transfer between the appliance
and assets.

You must also enter 1745 in the appliance
master ini file.

To do this:

1 In the appliance UI, select Configure >
Appliances > Edit > Advanced >
General Configuration.

2 In the Configuration Options Section,
select data in the Name column.

3 In the Edit Settings dialog, enter 1745
in the Value field and click Save.

Windows assets
protected with
image-level
backups

443:

• TCP

• Inbound from
protected asset

Appliance hostname
and IP

Asset hostname and IP
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Connectivity between the appliance and the Internet

Tasks Port, Protocol, and
Rule Hostname and IP Address Notes

Install product
updates and
access the
Unitrends
Community.

20 and 21:

• FTP

• Outbound

80:

• HTTP

• Outbound

repo.unitrends.com Used by the Unitrends appliance to
perform software updates.

Web access
Once you have configured network settings, you can access the appliance UI by entering its IP address in a Firefox or
Chrome browser. (Internet Explorer is not supported.)

Virtual machine resource requirements
Before deploying, verify that your host has sufficient resources to create the Unitrends Free VM. If minimum required
resources are not available, deployment may fail.

The following resources are required to deploy the Unitrends Free VM:

Note: These are the minimum resources required to deploy and begin using the Unitrends Free appliance. As you
add jobs and storage, be sure to monitor the system and add resources as needed over the lifetime of the
appliance.

• A minimum of two virtual processors (CPUs).

• A minimum of 4GB of RAM.

• 100GB of space for the VM’s initial disk.

• At least 200GB of backup storage.
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Chapter 3: Determining your Storage
Strategy

Before deploying your Unitrends Free appliance, you must determine the strategy to use for all backup storage. It is
important to plan your approach carefully because you cannot change this initial configuration. You must use VMDK
disk storage created by using the ESXi host. You can create VMDK disks by using direct attached storage (DAS, internal
to the hypervisor) or external SAN or NAS storage that is connected to the hypervisor. Using external storage attached
directly to the Unitrends Free VM is not supported.

Although you cannot change the initial configuration, you can add more storage to your appliance as your storage
needs change. Add virtual disks to the Unitrends Free VM by using the hypervisor and expand the initial backup storage
to include them. (See in Procedures for adding attached disk backup storage in the Administrator Guide for Recovery
Series, Recovery MAX, ION/ION+, and Unitrends Backup for details.)

How Unitrends Free appliance storage works
An initial disk of approximately 100GB is used to deploy the Unitrends Free VM. You must also add a minimum of
200GB as the initial backup storage. You cannot complete deployment without adding the initial backup storage
because this storage contains the appliance’s unique data and is used to store backups.

Storing the appliance’s unique data separately from the initial disk enables you to reattach the backup storage to a
new Unitrends Free VM to recover the original appliance's settings and backups.

Storage recommendations
Consider the following recommendations when determining your storage approach.

WARNING! Unitrends strongly recommends that all Unitrends Free storage is either direct attached storage (DAS,
internal to the hypervisor) or resides on one external storage array. If you configure storage across
multiple storage arrays and one becomes unavailable, all backup data ends up corrupted, resulting in
total data loss.
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Unitrends
Free Storage
Component

Recommendations

All These recommendations apply to all Unitrends Free storage (initial disk, initial backup storage, and
additional backup storage):

• Unitrends strongly recommends using hypervisor-certified storage arrays on VMware’s
hardware certified list for deploying Unitrends Free appliances.

• Once you have selected a type of backup storage, Unitrends recommends using the same
type of storage to add more backup storage in the future.

• Do not use Storage vMotion. Storage must remain in a fixed location.

• Use VMDK disks for Unitrends Free storage. Do one of the following to create VMDK disks:

– Create VMDKs on storage internal to the hypervisor (DAS).

– Expose a SAN or NAS to the hypervisor and use the hypervisor to create a datastore from
this storage. You can then select this datastore to create VMDKs.

Note: Attaching external storage directly to the Unitrends Free VM is not supported.

Initial disk You create the Unitrends Free VM by running the Windows EXE installer or by deploying the OVA file.
During deployment (described in "Deploy the Unitrends Free VM" on page 18), you make various
selections within your hypervisor, including the datastore and disk format used to create the initial
disk for the Unitrends Free VM.

The initial disk can reside on DAS storage internal to the hypervisor or on external storage attached
to the hypervisor.

Initial backup
storage

You must add a minimum of 200GB of initial backup storage. For disaster recovery, it is important
to know which VMDK was used as the initial backup storage, so make sure to keep a record of your
selection.

To set up the initial backup storage, you must add a VMDK to the Unitrends Free VM by using the
ESXi host (see "Step 4: Attach backup storage (if needed)" on page 31). The appliance
automatically uses the first VMDK disk that was added to the Unitrends Free VM as the initial
backup storage.
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Unitrends
Free Storage
Component

Recommendations

Additional
backup
storage

It is a best practice to add storage in the same way you created the initial backup storage.
Unitrends recommends expanding storage for best performance, but you can add a separate
storage area of roughly the same size if necessary.

When you add attached disk storage, the VMDKs display in the Unitrends Free UI as /dev/sdx/. The
x indicates alphabetically the order in which the storage was added.

For example, the initial disk is always /dev/sda/, the initial backup storage is /dev/sdb/, the next
would be /dev/sdc/, and so forth.

The following requirements apply to additional backup storage:

• Your backup storage devices must be at least 200GB to enable deduplication.

• As you add more storage, be sure to add resources to the Unitrends Free VM, such as CPU
and memory.

• You can expand backup storage only across new disks. To expand the existing backup
storage, you must add a new virtual disk. Expanding an existing VMDK is not supported.

Expanding
storage

To add backup storage, Unitrends recommends expanding your initial backup storage to include
the newly allocated space. Once storage is expanded in the Unitrends Free UI, the appliance treats
the original disk and added disks as one larger data volume. For details on expanding storage, see
Procedures for adding attached disk backup storage in the Administrator Guide for Recovery
Series, Recovery MAX, ION/ION+, and Unitrends Backup.

Adding a
separate
storage
device

If expanding storage is not an option, or you need to create a distinct storage area, you can add a
separate storage device to your appliance. The storage you add is treated as a separate storage
area. This approach allows you to set up backups to write to a specified device.

Use the hypervisor to add a VMDK to the Unitrends Free VM. Then go to the Add Backup Storage
dialog in the UI, click Create a separate storage area for an alternate backup device and select
the type Added Disk. Select the disk to add. For details on adding storage, see Procedures for
adding attached disk backup storage and in the Administrator Guide for Recovery Series, Recovery
MAX, ION/ION+, and Unitrends Backup.
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Chapter 4: Deploying a Unitrends Free
Appliance

Deployment consists of creating the Unitrends Free VM, attaching backup storage, and configuring appliance settings.

To create the Unitrends Free VM, you either run a Windows EXE installer or deploy an OVA file. (See "Hypervisor
requirements and considerations" on page 7 to determine which method to use for your ESXi host.) During deployment,
you define network and storage settings for the appliance.

The following steps summarize the procedures used to deploy your Unitrends Free appliance. Detailed instructions for
each procedure follow:

Note: Required steps vary depending on the type of storage you are using and whether you deploy using the EXE or
OVA method. Step 4: may not be required.

• "Step 1: Set up storage on the hypervisor" below

• "Step 2: Download the OVA or EXE" on page 16

• "Step 3: Deploy the Unitrends Free VM" on page 18

• "Step 4: Attach backup storage (if needed)" on page 31

• "Step 5: Set up the appliance using the Quick Setup Wizard" on page 40

• "Step 6: (Optional) Modify deduplication settings" on page 45

• "Step 7: Start protecting your environment" on page 46

Step 1: Set up storage on the hypervisor

Verify that the hypervisor has enough storage available:

• 100GB for the Unitrends Free VM's initial disk.

• At least 200GB for the initial backup storage.

If necessary, add storage. Storage options are described in the following table. For more on storage, see "Determining
your Storage Strategy" on page 11.

Storage option Requirements

Deploy using new
storage

Use added disk (DAS or external) storage for both the initial disk and initial backup storage.
Verify that the hypervisor has enough storage to create the initial disk and the initial
backup storage.
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Storage option Requirements

Deploy using storage
that contains backups
from another
Unitrends Free
appliance

Verify that the hypervisor has enough storage available to create the initial disk. You will
add the storage that contains backups after you deploy the Unitrends Free VM (as
described in "Attach backup storage (if needed)" below).

IMPORTANT! If you will be using the EXE installer, do NOT select the option to create
and attach a virtual disk to use as backup storage in "Step 3: Deploy the
Unitrends Free VM". You will need to create the initial backup storage
after you deploy the Unitrends Free VM (as described in "Step 4: Attach
backup storage (if needed)").

Step 2: Download the OVA or EXE

An EXE installer (most paid ESXi versions) or an OVA file (free ESXi versions) deploys the VM. You must download the
EXE installer or OVA file and save it on the machine you will use to access your ESXi server for the deployment.

To download the EXE or OVA:

1 Go to https://www.unitrends.com/download/free-backup-vmware-hyper-v-software, complete the form under
Download Unitrends Free Now, and click Submit.
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2 Select VMware vSphere. Click to download the EXE or OVA and save it on the machine you will use to access your
ESXi server for the deployment.
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3 Proceed to "Step 3: Deploy the Unitrends Free VM".

Step 3: Deploy the Unitrends Free VM

Deployment instructions remain the same whether you are setting up Unitrends Free with new storage or with storage
that contains backups from another Unitrends Free appliance. Use one of the following procedures:

• "Deploying with OVA"

• "Deploying with EXE" on page 27

Deploying with OVA
Use the following procedure to deploy the Unitrends Free VM by using the OVA file.

Note: You must use the OVA to deploy to a free ESXi version or to a paid version of ESXi 7.0. For other paid ESXi
versions, Unitrends recommends using the EXE installer (see "Deploying with EXE" on page 27).

To deploy the Unitrends Free VM using the OVA file

1 From the machine on which you saved the Unitrends Free OVA file, access your ESXi server using vSphere Client.

2 Select File > Deploy OVF template.

3 Browse to the extraction location, select VMware-UF-version.ova, click Open, then click Next.
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4 Verify OVA details and click Next.
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5 Enter a display name for the Unitrends Free VM. The name can contain only alphanumeric characters, dashes, and
underscores. This is the name that will display for the VM in your hypervisor. Click Next.

6 (Optional) If your environment has resource pools, you can opt to choose one for the Unitrends Free VM. If your
environment does not have resource pools, you do not see this step. Click Next to continue.
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7 Select the datastore that will be used to create the Unitrends Free VM. Click Next.

8 Select the disk format type. Click Next.

For best performance, use a thick provisioned format.

9 If the server has multiple virtual networks, select one from the list and click Next. If the server has only one virtual
network, you are not prompted for a selection.

10 On the Ready to Complete screen, select Power on after deployment.

11 Click Finish to deploy.
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12 When deployment is complete, close the confirmation message:
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13 Do one of the following:

• If the virtual network has DHCP available, proceed to "Step 4: Attach backup storage (if needed)" on page
31.

• If DHCP is not available or if you prefer to assign a static IP address, proceed to "To set up the appliance with
a static IP address" on page 23.

To set up the appliance with a static IP address

Note: If you will be attaching storage from another Unitrends Free appliance that contains backup data, you can
enter the same network settings as the original appliance or use different network settings.

1 From vSphere Client, access the Unitrends Free VM's console interface by clicking the Launch Virtual Machine
Console icon. (The icon looks like a computer with a green arrow pointing up.)

Note: The Unitrends Free VM must be turned on. If necessary, right-click the VM and select Start.

The remaining steps are run from the Unitrends Backup console interface. On these screens, you select a menu option
by entering a number in the Please enter choice field.

Notes:

• As you complete each step in the Unitrends Backup Console Interface, you are presented with the next
configuration screen.

• You can press Enter to accept the default or current setting.

2 On the Console Interface screen, enter 1 in the Please Configure Console Access Password... field.

3 To change the direct console password, enter a new password, then enter the password again to confirm.
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Notes:

• This is the root operating system password that accesses the console. This password does not access the
UI. (You will change the UI password in "Step 5: Set up the appliance using the Quick Setup Wizard" on
page 40.)

• All appliances are deployed with these default operating systems credentials: user root, password
unitrends1. For appliance security, you must change this password.

• For increased security, ensure that the password you enter is different than your UI user password.

4 On the Console Interface screen, enter 2.

5 On the Initial System Setup Menu screen, enter 1 in the Please enter choice field.

6 Enter a number in the Select a network adapter field. For example, enter 0 to select eth0.
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7 Enter Y in the Edit network configuration field. Then enter an IP address, Netmask, and Gateway. Review the
settings and enter Y to save.

8 To configure DNS settings, enter 2, then enter Y to edit. Enter the Primary DNS IP address, a Secondary DNS IP
(optional), and a DNS Domain. Review the settings and enter Y to save.
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9 To exit network setup, enter 6.
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10 Exit the VM console.

11 Proceed to "Step 4: Attach backup storage (if needed)" on page 31.

Deploying with EXE
Use the following procedure to deploy the Unitrends Free VM by running the EXE installer.

Note: Use this procedure for paid versions of ESXi only. To deploy to a free ESXi version or to a paid version of ESXi
7.0, see "Deploying with OVA" on page 18.

Prerequisite if using external storage

To create the VM's initial disk from external storage, use the hypervisor to add the SAN or LUN and associated
datastores before running the EXE installer.

To deploy the Unitrends Free VM using the EXE installer

1 Save the EXE installer file to a Windows machine.

2 Double-click VMware-UF-version.exe. It runs automatically.

3 Enter the IP Address or Hostname of the vCenter or ESXi host and its Username and Password. Click Next.
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4 Enter the following:

• Appliance Name — Enter a display name for the Unitrends Free VM. The name can contain only alphanumeric
characters, dashes, and underscores. This is the name that will display for the VM in your hypervisor.

• VMware Host — Select the ESXi host. If you entered the IP address for an ESXi host in the previous step, this
host displays here and you can select it. If you entered the IP address for a vCenter server, use the drop-down
menu to select one of the ESXi hosts it manages.

• Datastore — Select the datastore to use to create the Unitrends Free VM.
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5 Click Next.

6 Select a virtual Network for the Unitrends Free VM to use on the host:

• If DHCP is available, networking details are added automatically.

• If DHCP is not available or if you prefer to assign a static IP address to the appliance, enter an IP address,
Netmask, Gateway, and Primary DNS.

Note: Make a note of the appliance IP address. You will need it later to log in to the appliance user
interface.

7 Click Next.
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8 Create a virtual disk to use as the initial backup storage (or opt to use existing storage) by entering the following
information:

• Add a new virtual disk to use as backup storage — Selected by default. Do one of the following:

– Leave this box checked to create added disk storage. The appliance automatically designates this disk
as the initial backup storage. (You will select the datastore to use below.)

– Clear this box to use storage that contains backups from another Unitrends Free appliance. (You will add
this storage later.) Proceed to step 9.

• Disk Size — Defaults to 200GB. Adjust the size of the attached disk, up to 2TB. The size cannot be less than
200GB.

• Datastore — Defaults to the first available datastore. You can edit the selection.

• Disk Provisioning — Defaults to Thick Provision Lazy Zeroed. You can edit the selection.

9 Click Install. This creates the Unitrends Free VM on the virtual host, using the settings you defined in the previous
steps.
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10 Once installation completes, select Open a browser and connect to your appliance to complete configuration.
This opens Chrome or Firefox to the IP address defined for the appliance. If neither of these browsers is available
on your machine, Internet Explorer opens. This browser is not supported, and Unitrends recommends using
Chrome or Firefox; however, you can complete the Quick Setup Wizard using Internet Explorer.

(If you do not select Open a browser and connect to your appliance to complete configuration, you must
manually open a browser and enter the IP address you assigned to your Unitrends Free appliance after the
installation completes.)

11 Click Finish.

12 Proceed to one of the following:

• If you created the virtual disk in step 8, proceed to "Step 5: Set up the appliance using the Quick Setup
Wizard" on page 40.

• If you did NOT create the virtual disk in step 8, proceed to "Attach backup storage (if needed)".

Step 4: Attach backup storage (if needed)

Note: If you ran the EXE installer and selected the option to create the virtual disk, the initial backup storage has
already been attached. Proceed to "Step 5: Set up the appliance using the Quick Setup Wizard" on page 40.

In this step you will attach the initial backup storage. Note that once you finish deploying and setting up your Unitrends
Free appliance, you can add disks at any time to increase backup storage capacity to protect up to 2TB of unique data.

Attach backup storage by using one of the procedures in this section if either of the following apply to your deployment:

• You deployed the Unitrends Free VM by running the OVA installer.

• You deployed by running the EXE installer but opted to create the initial backup storage by attaching storage that
contains backups from another Unitrends Free appliance.

Instructions for attaching storage vary depending on whether you are using new storage or using storage that contains
backups from another Unitrends Free appliance. See one of the following topics:
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• "Attaching new backup storage"

• "Attaching storage that contains backups from another appliance " on page 32

Attaching new backup storage
Add a VMDK to the Unitrends Free VM by using the ESXi host. The appliance automatically uses the first VMDK disk
that was added to the VM as the initial backup storage. Once you have added the VMDK, proceed to "Step 5: Set up
the appliance using the Quick Setup Wizard" on page 40.

For instructions on creating and adding a disk, see one of the following VMware documents:

– vSphere 5.5: Create a Virtual Disk in vSphere Client 5.5

– vSphere 6: Create a Virtual Disk in vSphere Client 6

– vSphere 6.5: Add an Existing Hard Disk to a Virtual Machine

– vSphere 6.7: Customize the Virtual Machine Settings in the VMware Host Client

– vSphere 7.0: Customize the Virtual Machine Settings in the VMware Host Client

Attaching storage that contains backups from another appliance

IMPORTANT!

• Attaching backup storage that contains backups from another Unitrends Free appliance is supported only if the
original appliance is running the same operating system as the newly deployed appliance. Appliances deployed
with version 10.3.6 or higher run CentOS 7. Appliances deployed with older versions run CentOS 6. To check the
appliance Recovery OS version, click on ? > About:
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• You must configure all storage that contains backup data from another Unitrends Free appliance before you do
"Step 5: Set up the appliance using the Quick Setup Wizard" on page 40. If you add this storage after you set up
the appliance, any data on the storage is deleted.

• Be sure to attach the VMDK that was used as the initial backup storage first (before adding any other VMDKs).
Adding the wrong VMDK first yields undesirable results. The appliance automatically uses the first VMDK you
attach as the initial backup storage. The appliance then recognizes all subsequent attached disks and can
access all existing backup data.

To add a VMDK that contains backups from another Unitrends Free appliance:

1 Access your ESXi server using vSphere Client.

2 Power off the original Unitrends Free VM.
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3 Identify the disk(s) that you want to add to the newly deployed VM by doing these steps:

• Right-click the original VM and select Edit Settings.

• Select each hard disk to view details. Note the disk file details of the one(s) you will add to the newly
deployed VM. (You will need the datastore and disk name to locate the disk in vSphere Client).

Notes:

• You must add all backup storage disks from the original VM.

• Do not add Hard Disk 1. This 100GB disk was created during VM deployment and is NOT used to store
backups.

• You must add the first backup storage disk (typically Hard Disk 2) before you add any other backup
storage disks.
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In our example, the VM has only one backup storage disk:

4 Add the disk to the newly deployed VM by doing these steps:

• Right-click the newly deployed VM and select Edit Settings.
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• Select Hard disk 1, click Add, then OK.

• Select Hard Disk and click Next.
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• Select Use an existing virtual disk and click Next.

• Click Browse. Browse to the original VM's first backup storage disk and click OK.

37

Chapter 4: Deploying a Unitrends Free Appliance

Deployment Guide for Unitrends Free
on VMware

Release 10.6.1 | March 2022



• Click Next to continue.

• Click Next to accept the default Advanced Options.
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• Click Finish.

• Click OK.
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5 (If needed) If the original VM has multiple backup storage disks, repeat step 4 to add those disks.

6 After attaching all backup storage disks, proceed to "Step 5: Set up the appliance using the Quick Setup Wizard".

Step 5: Set up the appliance using the Quick Setup
Wizard

To start the setup process, log in to the appliance UI from any machine on the same network by opening a browser and
entering the appliance’s IP address followed by /ui/. The Quick Setup Wizard launches when you access the UI for the
first time.

To set up the appliance

Use this procedure to set up the appliance:

1 Open a browser and connect to your appliance by entering: https://<applianceIP>/ui. For example:
https://10.10.10.1/ui.

2 Click Accept to accept the license agreement.
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3 Set the appliance date and time by doing one of the following, then click Next:

• Select a Timezone. If needed, modify the appliance Date and Time.

OR

• Check the Use an NTP Server box to sync to an NTP server. (Optional) Enter your preferred NTP server
address.

4 Enter a Host Name, a Domain, and a new UI Password for the appliance. If needed, enter a new OS Password.
Confirm the passwords by entering them again in the fields to the right. Click Next.

Notes:

• The hostname can contain only alphanumeric characters, dashes, and underscores.
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• The appliance has a UI root user and an OS root user. These are separate accounts. Changing the
password of one root user account does NOT change the password of the other root user account. The UI
root user is used to log in to the appliance UI. The OS root user is used to log in to the appliance console or
for command line access.

• If you have already set the OS password, these fields are disabled in the Quick Setup Wizard.

• Passwords cannot contain the word Unitrend (case insensitive).

• The OS password must contain 8 or more characters.

• All appliances are deployed with these default UI and OS credentials: user root, password unitrends1. For
appliance security, you must change these passwords in the Quick Setup Wizard. For increased security,
ensure that the OS password you enter is different than the UI user password.

• After you finish the deployment procedures in this guide, you can set up additional UI users for the
appliance at any time. For details, see Users and roles in the Administrator Guide for Recovery Series,
Recovery MAX, ION/ION+, and Unitrends Backup, Appliance settings topic.

5 (Optional) To enable email from the appliance, check Enable email reporting and enter the following:

• The fully qualified domain name of the SMTP server.

• (If needed) If the SMTP server requires authentication, select Authentication required and enter a
Username and Password.

• Click + Add Recipients to add a an email recipient. Enter an email address in the Recipient field and select
one or more of the System, Jobs, and Failures options to specify which reports the appliance will send to the
recipient. Repeat as needed to add more recipients.

6 Click Finish.
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7 Do one of the following:

• If you deployed by using new storage for the initial backup storage, the Welcome to Unitrends Backup dialog
displays. Click Tour to view the product tour (or X to exit).

OR

• If you deployed by using storage that contains backups from another Unitrends Free appliance, click Recover
to add the backups to the appliance.
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8 If needed, change the appliance operating system password:

Note: All appliances are deployed with these default operating systems credentials: user root, password
unitrends1. For appliance security, Unitrends strongly recommends that you change this password. If
you deployed using the ISO, you should have updated this password already. If you deployed using the
EXE, this password has not been changed.

• On the Configure > Appliances page, select the appliance and click Edit.

• In the Edit Appliance dialog, click Advanced and select OS Password.

• Enter the current and new passwords, then click Save.
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9 Proceed to "(Optional) Modify deduplication settings".

Step 6: (Optional) Modify deduplication settings

Deduplication is a data compression technique that eliminates duplicate data blocks. To yield fastest performance, the
appliance is configured to use the Level 1 deduplication setting. You can opt to modify this setting to increase on-
appliance retention. Keep in mind that increasing the deduplication level decreases job speed.

To modify the deduplication level

1 From the Global options at the top of the UI, select Options > Deduplication Settings.

2 Select one of the following deduplication settings:

• Level 1 — Use this setting to optimize performance.

• Level 2 — Use this setting to balance performance and on-appliance retention.
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• Level 3 — Use this setting to optimize retention.

3 Click Apply Settings.

Step 7: Start protecting your environment

Deployment is complete and you can get started protecting your environment. For details, see the Administrator Guide
for Recovery Series, Recovery MAX, ION/ION+, and Unitrends Backup.
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